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Overview and hardware

Hotfix stone

Introduction
Hotfix or (hotfix stones) are decorations like rhinestones, rhinestuds, nailheads, etc. that can be glued on textiles or
other materials by heating them. This article introduces rhinestones (i.e. flatback hotfix stones), includes a size table
and explains how to apply hotfix stones to textiles using templates.
See also:
•• Stitch Era - creating hot fix designs
•• Stitch Era - creating embroidery with hot fix stones
• Heat press and Ricoo T538B heat press

Source: Sequin Pattern 2 [1]

“Flatback crystals which are often called
rhinestones have a faceted face one side and
a flatback on the opposite side usually with
a foiled backing. They are available in a
range of materials the cheapest being acrylic
and the highest quality and most expensive
Swarovski Crystal. They come in a range of
shapes and sizes the most popular of which
being the circular flatback you can see
above which are used for crystallizing such
things as nails, lips, clothing, footwear,
statues, artwork, gadgets and much more…”
(Guide to Using Flatback Crystals [2] (Oct 2,
2017).

According to Wikipedia [3], “Hot fix rhinestones, also called heat transfer rhinestones, are mainly used for apparel.
The flat bottom of the stone has a glue backing and when heated melts onto the surface of the clothing. These can be
adhered using a regular iron, however, it is recommended to use a heat press, as they are able to reach higher
temperatures (standard transfers require temperatures of up to 180–200 °C (350–400 °F), which regular irons are not
capable of) while applying heavy pressures resulting in a more professional standard quality.” (Oct 2, 2017).

http://www.publicdomainpictures.net/view-image.php?image=19771&picture=sequin-pattern-2
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ASequin-pattern-2.jpg
http://www.crystalandglassbeads.com/blog/2014/flatback-crystals-guide.html
https://en.wikipedia.org/wiki/Rhinestone
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Hotfix stone sizes and quality

An introduction to rhinestone size
Rhinestones size are either defined with "ss" (stone size) or pp (pearl plate). PP is a more precise measure.
According to Guide to Using Flatback Crystals [2] (Oct. 2017), as general guide, the following sizes are used:
• ss3 – ss7 : Nail art (7 being the more popular size)
• ss8 – ss10 : Generally used for filler crystals, tiny objects or creating intricate artwork with crystals in conjunction

with other crystal sizes.
• ss12 – ss20 : Footwear, clothing or accessorizing gadgets.
• ss30 – ss48 : Clothing especially dance costumes to add some sparkle.
According to Creative Crystal [4], customers, prefer 4mm (16ss), 3mm (10ss) and 7mm (34ss) in that order. Working
with SS16 allows for fairly good filled lettering or other details and manipulating these is not too much of a pain.
Working with small SS10 stones is a real pain ! I suggest that beginners should start with SS20 (4.6 to 4.8mm
depending on the make) or bigger. Below a picture of brushing SS16 stones into a template.

Brushing SS16 stones into a template

The procedure for computing the rough amount of stones needed:
•• Compute the surface in mm: width X length if you have a square
•• Select the stone size in mm
•• Divide surface / stone_size
Example: A filled circle of 10 cm (that is quite a lot !) to filled with stones that have a width (diameter) of 5mm.
• Surface of circle formula: radius2 * PI
• Surface: 3.14 * 502 = 7854 mm2

• SS22 surface: 52 = 25 mm2

•• Stones needed: 7850 / 25 = 314

http://www.crystalandglassbeads.com/blog/2014/flatback-crystals-guide.html
https://www.creativecrystal.com/pages/hot-fix-crystal-sizes-made-simple
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-brushing-SS16s.jpg
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Size table
The following table includes approximate rounded mm values. Various source on the Internet include contradictory
information. Do not trust these values, verify with other sources please. Also, different manufacturers, may use
somewhat different sizes. Sizes in bold are supported by the Hotfix Era software. Sizes of 6, 10, 16, 20, 30, 34 and
40 can be easily found with online retailers such as AliExpress or Amazon.
The table below includes typical width and height. We also will try to add information about time needed in the heat
press at 200C and tolerable thickness of template materials. Time for heating is probably dependant on both the
tissue and the make of the stone.

ss pp ø mm ø Svarovski Typical Height mm Heat press time (provisional) Template thickness (provisional)

000 1 0.8 - 0.9

00 2 0.9 - 1

0 3 1.0 - 1.1

1 4 1.1 - 1.2

2 5 1.2 - 1.3

2½ 6 1.3 - 1.35

3 7 1.35 - 1.4 1.4

3½ 8 1.4 - 1.5

4 9 1.5 - 1.6 1.6

4½ 10 1.6 - 1.7

5 11 1.7 - 1.8 1.8

5½ 12 1.8 - 1.9

6 13 1.9 - 2.0 2.0

6½ 14 2.0 - 2.1

7 15 2.1 - 2.2 2.2

7½ 16 2.2 - 2.3

8 17 2.3 - 2.4 2.4

8½ 18 2.4 - 2.5

9 19 2.5 - 2.6 2.6

9½ 20 2.6 - 2.7

10 21 2.7 - 2.8 3.0 1.4

11 22 2.8 - 2.9

11½ 23 2.9 - 3.0

12 24 3.0 - 3.2 3.2

13 25 3.2 - 3.3

13½ 26 3.3 - 3.4

14 27 3.4 - 3.5 3.5

14½ 28 3.5 - 3.6

15 29 3.6 - 3.7

15½ 30 3.7 - 3.8

16 31 3.8 - 4.0 4.0 1.5 20s 0.5 to 1 mm
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17 32 4.0 - 4.2

17½ 33 4.1 - 4.2

18 34 4.3 - 4.4

18½ 35 4.5

19 36 4.5 - 4.6

19½ 37 4.5

20 - 4.6 - 4.8 4.8 2

21 - 4.8 - 4.9

22 - 4.9 - 5.0

23 - 5.0 - 5.2

24 - 5.2 - 5.4

25 - 5.4 - 5.6

26 - 5.6 - 5.8

27 - 5.8 - 6.0

28 - 6.0 - 6.2

29 - 6.2 - 6.4

30 - 6.4 - 6.6 6.5

31 - 6.6 - 6.8

32 - 6.8 - 7.0

33 - 7.0 - 7.2

34 - 7.2 - 7.4 7.0 3 30s

35 - 7.4 - 7.6

36 - 7.6 - 7.8

37 - 7.8 - 8.0

38 - 8.0 - 8.2

39 - 8.2 - 8.4

40 - 8.4 - 8.7 8.5

41 - 8.7 - 9.1

42 - 9.1 - 9.5

43 - 9.5 - 9.8

44 - 9.8 - 10.1

45 - 10.1 - 10.5

48 - 10.9 - 11.3 11

50 - 11.7 - 12.0

60 - 14.2 - 14.5

63 - 15.0 - 15.2

70 - 16.7 - 17.0

80 - 19.2 - 17.5

83 - 20.0 - 20.2
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Quality
Hotfix Rhinestones come in several varieties and qualities. From our little experience we can see different quality
dimensions:
•• Quality of glue
•• Quality of cut (even)
•• Number of faces / cuts
•• Foiling (backing): silver, aluminium, lead, etc.)
•• Stone assembly: stone + metal sheet + glue
•• Form: Regular or irregular. Do the sizes (radius, height) match ? Are the stones really round ?
•• Overall vs. total quality. Lower quality sets may have bad stones inside.
•• Contains no lead (required in principle for children's wear).
•• Glue: It should stick and be washable.
Generally speaking, a good rhinestone should sparkle from all angles, have the regular and same dimensions, and
stick to the fabric.

2078 HF XIRIUS Rose
Hotfix

Below are a few recommendations that summarize information that is circulating on line
• Swarovski [5] Rhinestones are made in Austria and seem to have the best quality in

any color. There a several models. A well known type is the XIRIUS Rose Hotfix
2078 HF which has 16 cuts (8 large and 8 smaller ones plus the one on top.

•• 100 4mm (SS 16) can cost between 5 and 20 Euros on Amazon.fr
•• 1440 SS16 can cost 55 Euros.

• Preciosa [6] Rhinestones are made in Czech Repulic and are cheaper than Swarovski
stones. Quality seems to be almost the same for similar models. SS16 are available
with 12 faces (MC Chaton Rose VIVA12 line) or 8 faces (Chaton Rose
MAXIMA(8F). More complex stones also exist for larger sizes. Below a few randomly collected prices.

•• 350 SS16 cost 5 Euros on Amazon.fr.
•• 1440 SS16 can cost between 7.5 (discount) and 55 Euros. A typical price is 36 Euros for a SS 16 Chaton Rose

VIVA12
•• DMC rhinestone (Diamant Machine Cut) is a korean rhinestone company that produces comparatively high

quality, but much cheaper than Swarovski. Stones have 12 faces.
•• E.g. 1000 SS 16 can cost 10 Euros. On AliExpress I have seen offers for 1440 pieces at $5.

One should distinguish between the orginal Korean DMC's and the ones that are produced in China. Often, "DMC"
does not stand for a brand, but is an indicator of decent quality.
•• Blue Nil is an other good brand

•• 1440 SS16 can cost about 30 Euros
•• No name brands can offer suitable quality and they can cost 10 times less than the top Swarovski brand. But there

is no guarantee that sizes are even, workmanship is good enough and glue will stick. Enquire before you buy or
else keep at least track of the ones you did like.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ASwarovski-xirius-rose-2078HF.png
https://www.swarovski-professional.com/
http://preciosacomponents.com/en/
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Software

Embroidery software
Stitch Era includes an optional module for hotfix designs. It can output design stencils or templates that can be
printed with different laser and vinyl cutters.
The software allows drawing shapes that then can be filled with slots for stones according to several parameters.

Online auxiliary tools
(to do)

Materials suitable for hotfix

Hotfix stones on non-textiles

Hotfix stones can be applied to variety of
textiles and other materials. According to
Understanding Hotfix [7] by Harman, hotfix
rhinestones should only be used when the
material it is being applied to has all of the
following attributes:

1.1. Heat resistant (min of 250°F/ 120°C)
(e.g most plastics are not heat resistant)

2.2. Resistant against pressure
3.3. Porous/Absorbent - it does have any

waterproof or other coating that would
make it non porous. The water drop test
is a quick and easy way to get an initial
idea of the absorbency of the carrier
material. Apply a couple of water drops onto the carrier material. If the material quickly absorbs the drops, it
offers good absorbency. If the water pearls off the carrier material, or if it takes a long time to be absorbed, the
material offers insufficient absorbency.

They also provide a list of unsuitable fabrics, e.g. very tightly woven textiles, extremely thin fabrics, smooth leather
and smooth imitation leather and water repellant treated materials.

Applying hotfix stones
To position hotfix stones, it is best to use a template made with a laser or a vinyl cutter. The template allows
positioning of the stones. If you use an iron or a heat press, you can keep the template in place. However, make sure
that it is heat resistant, e.g. in particular never use vinyl with PCB inside since burned vinyl releases very dangerous
combat gas !

Principle
Hotfix stones can be fixed with different methods. All of them are defined by four parameters
•• Amount of heat depends on the maker. E.g. Swarovski has a range of 120 °C to 170 °
•• Time: E.g. max. 20 seconds for 160 °C and 60 seconds for 120 °C when applied from the front.
•• Pressure: A certain amount of pressure must be applied but not too much since otherwise the glue will spread out.

Also if you use an applicator the stone can either get stuck in the opening or not stick, i.e. you will have to find a
good compromise.

http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_embroidery_software
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ARhinestone-bike.jpg
http://www.harmanbeads.com/understanding-swarovski-hot-fix-rhinestones
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•• Side of application (from top or from underneath)
Both time and heat parameters are highly connected. Higher temperature requires less time.
Before using any tool / textile / stone combination for real, do a test !!

Hardware for hotstone application
Probably the best bet for a beginner is to start using a cheap hotfix applicator. Presses are fairly expensive and
working with an iron is a bit more tricky.
As a general rule:
•• position the fabric on a surface that is heat resistant, e.g. a sheet of metal or a heat-resistant cutting mat
•• separate layers of fabric underneath with baking paper, else they may be glued together
• Make sure to heat enough (at least 120 degrees and make sure that the textile will not melt, i.e. do not use

plastics)
Hotfix applicators

Hotfix applicators are cheap devices that look a bit like a soldering iron. They allow heating a hotfix stone one by
one. It includes removable ends that will adapt to various hotfix forms. Better ones can aspire the stones. A cheap
application costs about 10 Euros. One that includes a vacum mechanism is about 100.-
There are two variants:
•• Grab a stone from the top. If you are lucky it should stick, then let it heat. As soon as the glue softens or boils,

press it down a few seconds.
•• Put the stone on the textile. Then then press the hot applicator down.
In both cases, you can apply a very slight rotational movement to make sure that each part sticks. But do not move
the stone and do not apply too much pressure.
Iron without holes

A simple iron (without holes) also can do, heat it to 150°C (that is position 2 on a normal iron). Put cardboard or
baking paper underneath the cloth and then put either some baking paper or a flat kitchen towel in between the iron
and the stones. Alternatively you can buy more professional fabrics, e.g. teflon-based instead of baking paper. Press
it down for about 30 seconds for stronger fabrics.
Heat Press

A heat press or transfer press (presse à chaleur, Hitzepresse, Transferpresse) can glue a whole set. Heat presses also
can be used to transfer other materials, in particular cut out heat resistant plastics and textiles. A good beginner's
machine can cost 400 to 500 Euros, but one can find $200.- models on sale. High end models can cost from 1500.- to
2000.- There are a huge amount of various makers and vendors. Most do not include information about suitability for
hot stone application. See below for more details.
Ultrasonic devices

This looks an applicator but works with ultrasonic fiction as opposed to a heated end. More expensive. It allows to
pick up a stone.
Stone setting machines

Used in mass fabrication. Stones are placed and heated with a machine.
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Templates for hotfix
Templates are based on drawings that show position for each stone, typically with a circle. Hot fix software, like
Hotfix Era eases the design process.
There are two ways of using templates:
• Cut out the template with a laser cutter or a cutting plotter. Glue a sheet of something (e.g. thick paper)

underneath. Then fill the template with rhinestones. Transfer the stones to a textile using a transfer sheet.
Thickness of template should be 0.5mm for smaller stones, but it can be higher for larger stones (e.g. SS16 and
SS24).

•• Print a page with the design. On top, put transfer paper, sticky side up. Then manually put the stones upside down
(flat side up) on the sticky paper. Then transfer as above on top of a cloth.

The procedure of creating a template with the help of specialized software and some post-processing of the SVG
output is explained more in detail in the Stitch Era - creating hot fix designs article.

Fabrication with a template, transfer paper and a heat press
This section shortly explains how to apply hotfix stones with a heat press, positioning the stones with a template and
then transferring it to a heat press. The principle can also be used with a hot iron.

Heat transfer press specifications
Your heat press (we believe) should have the following specification.
• It should either have a large opening or a lateral swivel swing (Schwenkarm) or a drawer style lower plateau. A

swivel press is probably best if you plan to improvise a bit since it allows positioning things without hindrance
from the top.

•• It should provide an even distribution of pressure and temperature
•• It should auto-adjust pressure to uneven textiles, e.g. with springs on top of the heating plate and a somewhat

flexible mat.
•• I must allow height/pressure adjustment, i.e. dealing with the somewhat larger height of hot stones by moving the

heat plate up or down with a "pressure knob"
•• It should have anti-sticking coating underneath the heating plate (e.g. teflon)
• 38 x 38cm size should be enough (15x 15)
If not furnished with the model, you must buy a silicon mat to put underneath. If the top is not coated you must either
buy teflon sheet or else use baking paper. In any case, it is always good tu put baking paper [8] (also called bakery
paper or parchment paper) underneath the cloth and on top of the design. Do not used wax paper but as we said
above there are more professional solutions like teflon sheets. Also, if you use the transfer method, you could take a
teflon heat transfer sheet.
The usual procedure for design with lots of hot stones is the following

Step 1 - Create a template
Create a template, e.g. with some specialized software like Stitch Era that you can then print with a laser cutter or a
vinyl cutter. There are two options if you use multiple colors and sizes. Either create a single template or one for
each size/color combination. The latter may be easier for semi-industrial production, but I am not sure if heating the
same stones several times because of multiple passages into the heat press is a good idea. If you use a single
template, follow advice below on how to put the stones inside.
Search for "Rhinestone template material". I used both free compact cardboard and acrylic made for laser cutting.
Cardboard is better for brushing but the transfer paper may stick to it and rip some paper away (which is not a big

http://edutechwiki.unige.ch/mediawiki/index.php?title=Laser_cutter
http://edutechwiki.unige.ch/mediawiki/index.php?title=Cutting_plotter
https://en.wikipedia.org/wiki/Parchment_paper
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problem). Acrylic is maybe a bit easier for the transfer, but it is more expensive. In addition, acrylic material (such as
Trolase) will wrap in the laser cutter and the lens will be offset. Such a defocalised lens may not cut through the
material, will take away more material, and can cause the material burn. Supervise the laser cutter when you work
with light materials that can wrap (paper, cloth, thin acrylic, etc.). Anyhow, make sure to tape down the borders or
weight them down with flat and heavy objects.

Tape down before cutting many little holes

After cutting out the template, glue some thick paper to its bottom. This, in order to prevent the stones from falling
through and gliding underneath. However, also read my own more simple method in the next section, i.e. putting the
template on top of the cloth in the heatpress without doing any transfer. The latter method works rather fine for small
templates that use SS16 stones and higher.
By default I suggest using 0.7 to 1mm thick materials for SS16 stones and larger. SS10 stones (1.4mm height)
probably require less thickness than 1mm. Maybe thick paper could do. Otherwise try cardboard from single Malt
Whiskey cases (between 0.6 and 0.7mm).

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-laser-taped-down.jpg
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Glue some thick paper to the bottom of your templates

If the template is warped, something that can happen for larger designs or/and of the support material has different
"sides", we suggest gluing it to a sheet of plywood or MDF and then putting into the (cold) heatpress to make it flat.

Large template pressed flat and glued to a sheet of wood

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-gluing-paper-to-bottom.jpg
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-template-large-glued.jpg
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Step 2 - Brush the stones into the template
Put the rhinestone into the holes and make sure that all are in position.
To do so, put a whole big lot of stones over the stencil and then gently brush forth and back with a foam brush or a
piece of flat soft foam that you could retrieve from some packing or your matress. This technique works because
stones sitting on the flat side and in the right trajectory will be pushed into the holes and stick there. Turned stones in
the holes on the other hand will be removed. Again, make sure to pour a big pile of stones over the template.
Otherwise you will spend much more time brushing.
Make sure that there no extra stones left and that each stone is in position

Brush stones into the hole with a foam brush (or piece of soft packing foam)

Both cardboard and acrylic work (but do not insert acrylic into a heat press!)

Extra tips for single templates:
•• If you got stones of different sizes (e.g. SS16 and SS10) in your template, then brush in the big ones first.

Otherwise the small ones will go into the hole of the big ones and you will have to retrieve these, e.g. with a piece
of adhesive gum.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-brush-stones-into-template.jpg
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-two-templates.jpg
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•• If you got different colors of the same size, close the holes for the other colors with some tape and then remove
them gradually. Alternatively, create different templates, one for each color/size combination.

•• Make sure that the surface of the template is flat, in particular, holes should not have little walls sticking up.

Multiple sizes and colors. Use of tape to cover holes

Step 4
Once the stones are in place, put a heat resistant rhinestone transfer paper on top and press it down. Some transfer
paper, e.g. the one that would use for textiles may not have enough glue and the stones will not stick. Buy something
that is better or you will loose some hours to frustration ...

1mm cardboard template Stones sticking to transfer sheet Transfer sheet on top of cloth

Template is taped to table Turning the sheet allows checking positions Ready to press

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-template-multi.jpg
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHamburger-hotfix-embroidery-2.jpg
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHamburger-hotfix-embroidery-3.jpg
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHamburger-hotfix-embroidery-4.jpg
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Design, procedure and result of this hamburger "test" is discussed in more detail in Stitch Era - creating embroidery
with hot fix stones.

Step 5 - (Optional) check the pressure of the press
Make sure that the pressure is right with respect to the thickness of the material. According to Peggy Elliot's Heat
Press Application Tips: The Right Pressure [9]] “Too much pressure can cause over-application sometimes driving
adhesive out from the heat transfer vinyl so your final design is not properly adhered to the item you’ve decorated
and may fall off. Not enough pressure can cause under-application, designs may not be fully adhered to the fibers of
the garment and fall off.”.
As far as we can, the press must close very firmly without having to force down. E.g. If you cannot remove a sheet
of paper from an easily closed heat press, it is OK for pressing stones onto a T-shirt.

Step 6 - Insert cloth in press and flatten
Put the cloth in the press and (optionally) preheat for 5 seconds to get moisture out and to flatten the cloth
Now, if you have two layers of cloth (e.g. a T-shirt), put some baking paper, teflon sheet or similar between the
layers. Else, glue will not just glue the stones but also the textiles together. In any case we strongly suggest using
baking paper underneath the surface to be pressed since it also will protect the map from soaking glue.
Apply the transfer sheet with the attached stones on top of the cloth. Make sure to aim for the right place and
directions. To help with that you could marke the upper line with removable tape. Stretch out the transfer sheet, then
press it down from the top. Ask a second person for help if needed.

Step 7 - Press
Put baking paper on top to protect the teflon coating of the press.
Heat for about 20 seconds for SS16 stones at 200C. Larger stones may need more
•• Let it cool down entirely, then peel away the transfer sheet.
•• Make repairs with a stone applicator if needed or press the design again. However, second and third pressing may

dilute the glue a bit too much.

http://blog.stahls.com/heat-press-application-tips-heat-press-pressure/
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Using a template and a heat press the simple way
Since I was frustrated by some transfer paper onto which the stones would not stick, I came up with a more simple
solution on day one (i.e. my first design testing the newly arrived heat press)
I first created two designs using some nice acrylic plastic (because I didn't have any free cardboard at hand). Since
the transfer paper method did not work I found some cardboard raiding the cupboards and did it again

Laser cutting 0.8mm Trolase acrylic sheets

Create a cardboard template
•• Create a template from thin cardboard.
•• Thickness does not matter much if the stones stick out well and if it is thick enough for the "brushing method).
I measured the height of the rhinestones I got (don't know what brand they are):
•• SS16 - 1.5mm height
•• SS20 - 2mm height
•• SS34 - 3mm height
For example, as shown in the tests below, 1mm of cardboard for SS20 stones was OK, and 0.7mm carboard was OK
for SS16. I don't know if 1mm would be OK for SS16.
The template should be flat, otherwise the stones will move out of position (underneath the cardboard). Tape it down
if it bends a little.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-template-in-the-cutting.jpg
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Use the template in the heat press
Below are the steps. Follow all of them and think ! Since this procedure is not document in other places as far as I
can tell you may experiment a bit.
1.1. Put the cloth on the heat press (just one layer, else insert baking paper between the layers)
2.2. If the cloth is wrinkled, heat the press and press for 4 seconds.
3.3. Put the template on top of the smooth cloth and tape it down on the edges.
4.4. Insert the rhinestones as above (e.g. pour a big pile of stones on top and then use some piece of soft foam to insert

them into the holes)
5.5. Make sure that every stone is flat and that there are not stones left
6.6. Heat for 20 seconds at 200C
7.7. Wait to let it cool down ! Do not remove the cardboard before the stones are cold again

Before heating. Template will remain in the heat press

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-first-design-before-pressing.jpg
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Before heating. Position of stones looks OK

The next pictures shows the result. The colored stones were in the same "crystal" pack as a surprise. Unfortunately
they did not have glue at bottom. I only figured that after the second attempt to press them down. In other words, the
same design had been pressed three times with no apparent damage. The last version only includes the clear stones
and do have glue.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-template-in-heatpress.jpg
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After cooling down and removing the cardboard.

Tips
Disadvantage of this method may be that the cardboard can change its form after heating. Avoid cardboard with
paint. On the positive side, it seems that paint found on a typical cardboard box for office supplies does not melt. See
the two pictures below. Also the wrapping is probably due to the fact that one side had paint and the other did not.

Warped cardboard after use Warped cardboard back

You should tape down the cardboard before setting the stones. Use short length of tape and make "handles" so that
you can pull the tape away again before printing. Alternatively, use heat resistant tape such as Kapton. Ask a
3D-printing friend for some or order it from an online outlet. A friend also suggested trying out some special type of
glue on the backside of the template, i.e. 3M™ Repositionable 75 Spray Adhesive [10] (I did not try yet).

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-first-design-after-first-pressing.jpg
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-cardboard-after-2.jpg
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-cardboard-after-1.jpg
https://www.3m.com/3M/en_US/company-us/all-3m-products/~/3M-Repositionable-75-Spray-Adhesive?N=5002385+3293194087&rt=rud
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Taped template for SS16 stones, 4-5 empty holes remain

The picture below shows the result. It's not an artistic master piece. Choice of colors is bad, design could be
improved. But at this stage (our second hotfix) we were just testing the transfer method and therefore we are happy
with the result. The little oval design on top was made by hand for testing the use of the newly arrived heat press.
Two weeks before, we didn't even know that such things existed ...

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-cardboard-16ss.jpg
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SS16 stone design (our second hotfix design and print)

Ordinary grey cardboard does not seem to warp, neither in the laser cutter nor under the heat press. Below is rather
large example that taught me the limit of this method. This method only works if the fabric is totally flat (otherwise
stones will glide underneath the cardbord). Also, it is much more suitable for stones that are larger than SS16 and it
is not suitable for SS10 and smaller since these stones will not "sit" in position.
The following design was larger than the heat transfer press, i.e. about 55cm width. I just cut the template in two
halves and did the left one first.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-tecfa-1.jpg


Hotfix stone 20

Larger than the heat press design, "direct method"

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ARhinestone-prof-template.jpg
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Professor Strass

Links

Various
• Rhinestone [3] (Wikipedia)
• Understanding Hot Fix [7] (Harman), retrieved oct 2017

Transfer techniques
• How to Apply Hotfix Crystals [11], by: Khaled January 22, 2012, retrieved oct 2017
• How to apply hotfix crystals with an Applicator [12], Zyneri blogs, retr. oct 2017.
• How to Heat Press Rhinestone Transfers… the right way [13], Colman, retr. oct 2017.
• Help & Video Education [14] at Stahls.com [15], e.g.

• Guide: 7 Popular Heat Transfer Styles [16], Stahls.com (retrieved oct. 2017)
• The Ultimate Guide To Design Size & Placement [17] Stahls.com (retrieved oct. 2017)

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ARhinestone-prof.jpg
https://en.wikipedia.org/wiki/Rhinestone
http://www.harmanbeads.com/understanding-swarovski-hot-fix-rhinestones
http://www.crystalandglassbeads.com/blog/2012/how-to-apply-hotfix-crystals.html
http://zyneri.com/how-to-apply-hotfix-crystals-with-an-applicator/
https://colmanandcompany.com/blog/2014/06/press-rhinestone-transfer-right-way/
https://www.stahls.com/help-education?icn=topnavhtvt&ici=education
http://Stahls.com
https://www.stahls.com/guide-popular-heat-transfer-styles
https://www.teesandprints.com/wp-content/uploads/2017/01/Design-Placement-Guide-Links-20160929.pdf
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Using a heat presses
• See heat press
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Heat press
Draft

Introduction
According to Wikipedia [1], “A heat press is a machine engineered to imprint a design or graphic on a substrate, such
as a t-shirt, with the application of heat and pressure for a preset period of time. While heat presses are often used to
apply designs to fabrics, specially designed presses can also be used to imprint designs on mugs, plates, jigsaw
puzzles, caps, and other products.”
In french: "presse de transfert", "presse thermique", "presse à chaud". In german: transferpresse, hitze presse,
textilpresse

Selecting and buying a heat press
Serious hobby machines come in three formats: either as clam-shell type or with a swivel swing arm or with drawer
style lower plateau. As explained in the Hotfix stone article, we prefer the swivel model, since it allows working
with the inserted textile without being exposed to the heated top.
We own a Ricoo T538B heat press.
If you live in Europe, buying in Germany is probably cheaper. E.g. a same model was 300 Euros on the german and
500 on the french Amazon site. Most cheaper models seem to have small problems identified in various online
reviews. A good German make cannot be found under 600 Euros. However, we are a happy with "serious entry
level" one we bought.
Other models I had a look at: Low end (with hopefully acceptable quality)
•• Craftpress $295.00
•• Fenta Pink Hobbypress 270 CHF (30 x 23cm swivel model)

http://www.publicdomainpictures.net/view-image.php?image=19771&picture=sequin-pattern-2
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http://www.harmanbeads.com/understanding-swarovski-hot-fix-rhinestones
https://en.wikipedia.org/wiki/Parchment_paper
http://blog.stahls.com/heat-press-application-tips-heat-press-pressure/
https://www.3m.com/3M/en_US/company-us/all-3m-products/~/3M-Repositionable-75-Spray-Adhesive?N=5002385+3293194087&rt=rud
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http://zyneri.com/how-to-apply-hotfix-crystals-with-an-applicator/
https://colmanandcompany.com/blog/2014/06/press-rhinestone-transfer-right-way/
https://www.stahls.com/help-education?icn=topnavhtvt&ici=education
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•• Fenta Pink-Press, 360 CHF
•• Krativegewerbe.dh - 38 x 38 cm Swivelling transfer press, 360 Euros (looks like the Ricoo T438)
•• Hobbysqueezy, 250 Euros to 400 CHF (30 x 22cm), full opening, but no timer.
•• Profisqueezy, 38 x 38cm, 400 Euros
•• Ridgeyard 166 Euros (Amazon.fr)
• HobbyCut AA1-S (230 - 280 €), e.g. from airbrush [2]

•• Hyppypress
•• Happypress 3. 30 x 21cm, (340 Euros)
•• Ricoo Powerdwarf, 300x23 cm, Swivel, 260 Euros
• Ricoo T538-TB (340 €)
•• Ricoo T438M (300 to 500 Euros !)
Mid end

•• Secabo TC2 (23 x 33cm), 435 Euros
•• Secabo C2 (38 x 38 cm), 350 Euros
•• Secabo TC5 (38 x 38), 610 Euros.
•• Hotronix Digital Clam, $950$

Links
• Heat Press [1] (Wikipedia)
• Heat transfer vinyl [3] (Wikipedia)
• Dye-sublimation printer [4] (Wikipedia)
• Transfer paper [5]

• Help & Video Education [14] at Stahls.com [15], e.g.
• Heat Press Buying Guide [6] by Josh Ellsworth, stahls.com. (retrieved oct. 2017)
• Guide: 7 Popular Heat Transfer Styles [16], Stahls.com (retrieved oct. 2017)
• The Ultimate Guide To Design Size & Placement [17] Stahls.com (retrieved oct. 2017)
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Ricoo T538B heat press

Introduction
The Ricoo T538B heat press is a heat press suitable for various transfer prints, e.g. hotfix stones, sublimation print,
or various "iron on" plastics. TECFA received this model on October 18, 2017. Below, a picture of the first
interesting "print" in progress and you can see more pictures in the hotfix stone article.

Ready to go !

See also:
•• Stitch Era - creating hot fix designs
•• Hotfix stone

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-first-design-before-pressing-2.jpg
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Ricoo T538B heat press

Model price and specifications

• Model: Schwenk Transfer Presse T Shirt
Druck selber machen T538 [1]

• We bought it for 340€ + 21€ Shipping
on Amazon.de [2] and the list price is
higher.

Specifications and parts
•• It has a swivel swing arm which seems to

be safer to use and more practical for this
type of work.

• 38 x 38 cm (15) print area
•• It has springs (probably better for the

distribution of pressure) and a Svivel
system (easier positioning of the cloth
plus materials and probably better
protection against burns).

•• A fat black mat
•• Digital temperature (0-399 C) and timer setting (0-999 seconds)
•• Heat plate can be moved up or down (5cm distance max.)
•• 26 kg
There are three different control interface variants according to the manual. We got version II (picture shown
below).

First impressions
This models fits the requirements we outlined in the Hotfix stone article.
At the time of writing we did three hotfix stone (strass) prints. All went well and the interface is easy to understand.
By default, the temperature is already set to 200C and the timer to 10 seconds (that we changed to 20 seconds). I
have no idea if this machine is of professional quality, but it certainly beats applying stuff with an iron and I am
happy with the results so far. I do appreciate that pressure (i.e. distance) can be very easily changed and that there are
springs and a fat big mat that should distribute it evenly.
Although the machine takes up a lot of space I recommend that type of model for working with hotfix stones. I did
manage to print designs with SS20 and SS16 stones that I directly put on the t-shirt using a laser cut cardboard
template. No transfer sheet, just some baking paper on top :)
I have seen large price differences for this machine. Ordering from Germany to France for use in Switzerland went
fast and smoothly. It was packed in a big carboard box and stabilized by two solid packing foam elements.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ARicoo-T538B-heat-press.jpg
https://www.ricoo.eu/schwenk-transfer-presse-t-shirt-druck-selber-machen-t538b/a-10433/
https://www.amazon.de/gp/product/B01E45NMG0/ref=ask_ql_qh_dp_hza?th=1
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Instructions

Ricoo Variant 2 control interface

This applies to variant II
Ajust feet

•• The machine should stand very stable on
its four feet

•• Ajust the knobs below and make sure that
it does not wobble

Temperature setting

•• By default, after unpacking the
temperature was to 200C which is just
fine

• Press OK once - you should see P1-1 on
the screen

•• Use the up/down buttons to change
•• Press OK once if you want to change the timer or twice to exit
Change Temperature display from C to F (or the other way round):
• Press OK for 5 seconds - You should see P-3 on the screen
•• Press up or down arrow and confirm with OK for 5 seconds
Timer

• Press OK twice - you should see P-2
•• Adjust with up/down buttons. We set our default to 20 seconds.
•• Press OK to confirm
• You can test the duration by pressing Enter
Pressure adjustment

•• Is purely mechanical, i.e. electronics will not tell anything.
•• Before heating, test if the lever can be pulled down and at the same time offers some resistance (i.e. really applies

some pressure but not too much). Test with objects in place, e.g. textile, cooking paper, some rhinestones.
•• Adjust with the big knob on top of the vertical arm.
Warning

•• Do no heat over 220C
•• Tell people around you to be careful
•• To not open the svivel arm 180 degress (it becomes a bit unstable)
Daily operations

Move the heating platform out of the way, then add some baking paper, put the cloth and stones on top.
If you are ready add some baking paper again and switch the machine on. Wait until you hear the alarm for reaching
the full temperature (it is also on display), Then svivel the plate in place and press down. The timer will
automatically start after the lever is pressed down. Wait for the alarm to open (e.g. after 10 to 20 seconds according
to your settings).
In other words, you won't have to do much if you are happy with your settings.
Tips

•• When you press down, do not move laterally. Down means vertically down.
•• Let the stones cool down after opening. Do not try to pull anything away. The glue will still be wet !

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ARicoo-T538B-heat-press-variant-2.png
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•• Put the machine near a corner of a table. That way heat will not reflect on the table in open position. See the
picture below.

•• Do not burn the electric cable. Make that it goes down straight.

Ready to go !

Maintenance
Remove the the electric cable before any maintenance work !
The heating plate on top is teflon coated and should neither scratched with powder, brushes, etc. nor alcohol, benzine
and other solvants. Use a mild detergent and a soft cloth.
The bottom silicone mat can be pulled off and the sticky rests can be scratched away. The new one should be glued
with heat resistant glue, pressed down gently and left alone for 24h.

Links

Documentation
Official

• Schwenk Transfer Presse T Shirt Druck selber machen T538 [1] (Product Page)
• Manual [3] Operations manual in German)
General

• Heat press (Wikipedia) [1]

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ARicoo-first-day-1.jpg
https://www.ricoo.eu/schwenk-transfer-presse-t-shirt-druck-selber-machen-t538b/a-10433/
https://www.ricoo.eu/layout/bedienungsanleitung/gewerbe-industrie/transferpresse/Transferpresse_T538_B.pdf
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Hot fix

Stitch Era - creating hot fix designs

Introduction
This beginner's tutorial for the Stitch Era embroidery software explains how to create designs for hotfix stones.
Tutorial home page

Stitch Era embroidery software
Learning goals

Digitize a vector graphic into a hotfix stone (rhinestone, strass) design
Use various lettering methods
Manipulate hotfix area parameters
Edit individual hotfix

Prerequisites
Stitch Era embroidery software and Stitch Era - creating embroidery from vector images (in particular, be able
to create a design defined by vector graphics).

Next steps
Stitch Era - creating embroidery with hot fix stones

Related pages
Hotfix stone

Materials
You can reuse the pictures. In the wiki, click on picture to make it larger, then click again and save it.

Quality and level
This text should technical people get going with Stitch Era. I use it for an optional master degree course in
educational technology.

Last major update
October 2017.

Stitch Era includes an extension module that allows creating hotfix design templates (also called rhinestones or
strass). The module is also available as stand alone program under the name of ''Hotfix Era''. This software allows
filling "areas" with "holes" for hotfix stones according to various parameters. The design then can be sent to a vinyl
cutter or a laser cutter in order to create a template.
The principle for creating a hotfix design is the same as creating embroidery areas. Instead of filling with a stitch
patterns, areas will be filled with "beads", i.e. circles that position each bead. As explained in the hotfix stone article,
there are different methods to place the beads. Without much technology, one can:
•• manually set the stones with an applicator (a kind of soldering iron with a special tip);
•• or print the design on paper, put the stones in place on the paper (flat side down), apply a transfer sheet and then

move the attached stones onto the fabric.
Larger designs do need some technology. There are two options:

http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_embroidery_software
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_embroidery_software
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_embroidery_software
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_creating_embroidery_from_vector_images
http://edutechwiki.unige.ch/mediawiki/index.php?title=Laser_cutter
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•• Create a template, e.g., a 0.5mm thick cardboard, insert the stones, then as above, use a transfer sheet. It will
allow handling designs with hundreds of stones fairly easily.

•• Use a stone setting machine (various types exist, not discussed here)
The template method

We will use the template method. With the Stitch Era hotfix module, one can create a design template, export to a
vector fromat (e.g. SVG or DXF) and then cut out the holes with a laser cutter or a cutting plotter. Typically you
would use 0.5mm cardboard or some strong textile. Below, we quote the procedure from an older version Stitch Era
V11 manual [1] (retrieved oct. 2017), with slight modifications.
The key of this method is to create templates or stencils. Since you cannot easily sort out different sizes and colors
beads, you need one template for each different piece (different size, shape and color) your design uses. A template
is a rigid plate with a set of small deep (0.5 mm) depressions or marks, arranged according the design, in the places
where the hotfix pieces should be set. Marks have to be of the same shape of the piece they are intended for, but a bit
larger.
The idea is to spread a handful of hotfix pieces over the template and to let them to become trapped in the marks.
This happens because hotfix pieces have a flat side (the back) and a round side (the front). So, they become trapped
with the shining side up. Usually, a soft brush (e.g. foam) is used to drag the beads over the template until all marks
are occupied. Then, a sheet of transfer material (with the adhesive toward the pieces) is pressed by hand against the
template. When the transfer sheet is removed from the template, all beads are attached to it. The transfer sheet is then
placed on the garment placed in a heat press with the adhesive toward the garment. One also could use an iron,
however the result may not be as good since it it is difficult to apply it evenly with the right temperature and
pressure.
Hotfix can send files directly to some plotters and laser cutter brands. Instead we export to SVG format that we will
modify a bit before sending it to the laser cutter, i.e. in our setting the cutting lines must be red (RGB 255,0,0) and
have 0.01mm width. If not done in Stitch Era, we also will have to add a cutting rectangle around the design with
some margin and adjust the size of the whole print.
Stitch Era will automatically make the holes a bit bigger. E.g. an SS16 (3.8 to 4mm) stone will be represented with a
4.5mm circle, i.e. it will add 0.3mm (dec mm) to the 1.95mm typical radius of an SS16. This setting can be changed
in File tab, Preferences setup -> Application -> Project -> Hotfix -> Hotfix cutting margin. It probably should
be reduced if you have a laser cutter (see the test below). E.g. 0.2mm should be enough.
If you don't own a cutting plotter or laser cutter, you may use a cardboard around 0.5 mm thick and drill on it holes a
little larger than the beads, e.g. for an SS16 (4mm) use 4.5mm. You may use a Hotfix Era printout of the design 1:1
scale as a reference. Print on cardboard or glue the paper on top.
The drilled template can be glued on top of another board piece of the same size. The template will be ready to use.
If you do not glue something to the bottom, make sure to use a very flat surface and do not to move the template
while you fill it with stones. Otherwise you may have to restart since it may slip over the stones that are already in
place.

http://edutechwiki.unige.ch/mediawiki/index.php?title=Laser_cutter
http://edutechwiki.unige.ch/mediawiki/index.php?title=Cutting_plotter
http://www.stitchera.com/downloads/Documents/Era1140-9.pdf
http://edutechwiki.unige.ch/mediawiki/index.php?title=Trotec_Speedy_100R
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Different design methods
As for embroidery, Stitch Era with the hotfix module (or Hotfix Era) offers a whole range of design path for
hotfixing. Functionality can be different according to software level. Here we will discuss a version we obtained for
our students and that is integrated within Stitch Era.
As for embroidery, you could start designing from a raster image or from vector drawings and then digitize to hotfix
areas. On the hotfix side, you can draw high-level objects and fill them according to various parameters, you can use
a lettering module or you can work at the individual bead level. The moon below was created as vector graphics and
then filled with hotfix stones, using the "Single Hotfix Fill" pull-down menu in the middle (see below)

Hot fix tab and ribbon menus for hotfix areas

In the ribbon menu, there are about four hotfix creation tools. From left to right:
• Two tools for creating hotfix areas by clicking and/or dragging the mouse in the workspace. Use the context menu

(right click) to close a drawing and again to create it. Read the section of working with Bezier curves in Stitch Era
- vector graphics.

•• A button to create individual beads (Manual hotfix)
•• The text creation tool (will change the menu layout)
•• The conversion tool from vector objects to hotfix areas
In addition in the main menu (below the ribbon menu bar), there are tools that allow doing the same, in particular the
"Create Sections" and "Smart Design" pull-down menu.
On top of the beads palette you find three little pull down menus: The first two allow making modifications at the
beads level (e.g. Edit beads) and one below allows defining a background picture.
As soon as you click on a hotfixed area in the workspace the interface will adapt its ribbons to it. E.g. clicking on
text object will show hotfix text with two sub-tabs: text and layout as shown in the next screen capture.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-tab.png
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_vector_graphics
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_vector_graphics


Stitch Era - creating hot fix designs 32

Hot fix tab and ribbon menus for text

Size and placement
Before starting to design we suggest defining a "paper size" (or a "hoop size" if you also plan to add embroidery to
the design).
• Go to the Home
• Select Pages pull down menu
•• Either select an existing page size, or create a new one that you then can select.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-tab-2.png
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Select paper size

According to Danielle Petroskey's Ultimate Guide To Design Size & Placement [17] (retrieved oct. 2017), below are
the most common hotfix design sizes and placements for T-shirts:
Placement of centred design:

• Adult: 8-9cm (3–3.5)" down from the collar
• Youth: 5-7cm (2–3") down from the collar
•• Toddler: 5cm (2") down from the collar
Typical Sizes of a design:

•• Adult: 28x28cm (11x11")
•• Youth or small adult: 26x26cm (10.5x10.5")
•• Youth (small): 21x21cm (8.5x8.5)
•• Toddler: 14x14 (5.5x5.5")
You cannot do much wrong if you use a landscape A5 size (21 X 14.8 cm) or a 21x21 square. I.e. you can sketch a
design on some ordinary portrait A4 office paper.
A really big size for an adult is about 30 x 35.5cm
Sizes and placements for hoodies are similar. Of course, you can apply hotfix stone designs in other areas, e.g. on the
sleeves, down the front, on top of the back (similar as above), down the back, hip area, etc. The largest recommend
size by Danielle Petroskey is 30.5x35.5cm (12x14)

Vector graphics to hotfix
As with embroidery, you can create hotfix designs by drawing or importing vector graphics. In sum, the procedure
for translating a series of vector drawing objects to hot stone areas is the following.

Digitizing vector graphics
•• Create or import a drawing
•• For each object, make sure to define either a fill, a border or both.
•• Open the hotfix tab
• Select one or more or all objects and select a fill option in the single hotfix fill or assorted hotfix fill menu in the

middle of the hotfix ribbon menu bar (see screenshot below)

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-select-page-size.png
https://www.teesandprints.com/wp-content/uploads/2017/01/Design-Placement-Guide-Links-20160929.pdf
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•• This will create a hotfix object (path or area) with default values

Vectors graphics to hotfix (two yellow moons to the left)

If you cannot see the result:
•• Make sure to click on hotfix to the right in the menu bar (it must be green). At the same time, you could turn off

"auxiliar", i.e. not show the vector drawings.

Hide vectors, show hotfix

•• Click on the lightning bar on top,
i.e. generate the beads if its not
done automatically (or hit F9 or
FN-F9 on some windows machines)

The moons were created with
subtractive geometry as explained in
the Stitch Era - vector graphics article.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-vector-to-hotfix.png
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-show-hotfix.png
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_vector_graphics
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Parametrizing hotfix areas
Each hotfix object now can be reparametrized. Below we changed settings for the middle moon. We use SS20 stones
and an "HF inner ring fill" as you can see in the screen shot below.

Vectors graphics to hotfix (dark yellow moon)

You can specify additional parameters. The most important ones are:
•• Distance between stones (we suggest at least 1mm if you plan to work with templates, otherwise cutting the

template will not work)
•• Distance from borders. By default the stones are place on the borders. In many cases you will want to change this.

1mm spacing of 10ss stones within built-in lettering

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-area-parameters.png
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-params-4.png
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Distance of 16ss stones from borders (4mm) and spacing (1mm)

Visualizing the result
In order to see the result in a more telling way, hit F7 (or FN F7 on some machines, or use the little pull down menu
with the red ball in the main menu bar)
The following picture shows the three moons with three different fills:
•• left moon: HF Uniform fill
•• middle moon: HF Flexible fill
•• right moon: HF Flat fill
Only the Uniform fill will give good results in this precise case:

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-params-5.png
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Choosing the right fill. For moons, use Uniform fill

If none of the automatic fills looks OK, then play first with additional parameters. E.g. if we wanted a denser fill we
could have chosen Hexagonal fill (top ribbon menu, or initial layout in the Object manager). In the picture below, we
changed the fill of the left moon to Uniform fill / Hexagon variant.
If the result is still unsatisfactory, then choose the best automatic fill and then make manual changes.
• You can move and delete stones using Edit hotfix mode (pull down menu to the left on top of the palette).
• You can add stones using "Manual Hotfix" (select hotfix tab, then select the icon). Before you click, select the

right stone in the object manager. In our case (just for the fun of it) we added some grey stones on top of the
middle moon and also moved some of the blue ones. To exit from manual editing, click on another tab, then click
on "select object" for example.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-text-5.png
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Manually adding stones

Creating hotfix designs with digitized letters
You can create letters in different ways:
•• Use the Hotfix lettering functionality of which exist two variants:

•• Digitized fonts, i.e. fonts that are specially created for hotfix (recommended)
•• True type fonts that you can fill either along the borders, inside the fills, or both

•• Draw vectors, then digitize to hotfix (discussed in the next section)

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-text-7.png
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Select size and background
Before creating a hotfix design we suggest turning on a simulation of the cloth and then also add a "page size", e.g.
A5 landscape size as in the picture below.

Define a background fabric simulation

Enter the text with a nice font
For beginners, it is probably better to start using a digitized font, i.e. objects that have all the beads positioned in an
optimal way.
• Click on the Hotfix tab in the ribbon menu, the click on the Hotfix Text icon.
• Alternatively, in the Smart Design Popup, open the hotfix tab, and click on the Hotfix Text icon
In both cases you now should see the Hotfix menu bar. If it does not show click on the TEXT that shows on the
menu bar.
• To the left, in the ribbon menu bar, select Digitized and then choose a font.
•• Enter the text in text area in menu bar (To add a new line, hit CTRL-Enter)
•• Change size (30 in our case) and the alignment (middle in our case)

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-edit-background-fabric.png
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Define a background fabric simulation

Change the rhinestone tone and size
You now should select the rhinestone size:
•• Click on the rhinestone icon
•• Select one from the popup menu that includes a default palette of rhinestone sizes and colors
Hotstone sizes are usually defined by SS measures. You can have a look at size definitions in the size table. For
example:
•• SS6 = 2mm
•• SS10 = 3mm
•• SS16 = 4mm
•• SS20 = 5mm

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-text-2.png
http://edutechwiki.unige.ch/mediawiki/index.php?title=Hotfix_stone%23Size_table
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Select rhinestone from a palette

If the wanted size and color is not in the offered selection, then click on add bed at the bottom. You will get a popup
that will allow defining all sorts of colors, shapes and sizes. We chose SS16, standard shape and clear crystal color.

Define a new rhinestone bead for the palette

Now you could change many other parameters, but we find that the result as shown in the screen captures above is
pleasing enough and we will stop here.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-select-rhinestone-1.png
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-select-rhinestone-2.png
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Creating hotfix designs with TrueType letters
There are two ways of lettering with true type letters
(1) Using hotfix fonts
•• Advantages: faster, better initial placement of beads, text is editable. It is easy to move a letter up/down or change

its size as shown with the "TEST" word in the screen capture below.
•• Disadvantage: Shapes of letters are very difficult to manipulate. If we understood right, one has to disassemble

the design, then manipulate at the bead level. Shown with the "G" in the screen capture below.
(2) Going the vector drawing route.
•• Advantages: Better flexibility in drawing the "right" shape, i.e. vector letters are more easy to manipulate. A line

of text can be "ungrouped" and you then can easily change shapes. The same is true for generated hotfix objects.
These are ordinary hotfix areas and can be parametrized like any other of that kind.

•• Disadvantages: Text is not editable, each line must be defined separately. Generated areas are not optimised for
lettering.

Both can be filled (unless disassembled)
•• along the stroke defining the letter shape
•• inside the fills
•• both stroke (outline) and fill (inside shape).

Vector to Hotfix vs. Hotfix fonts

In provisional conclusion, I'd either use digitized hotfix fonts (see previous section) or vector fonts, depending on
how much I would need to modify the shapes of letters.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-text-4.png
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Export hotfix designs to a laser cutter
As explained above, there different ways of using hotfix designs. Since we got a modern little laser cutter, we will
export the design to SVG and then send it to the machine. The steps are fairly simple. Firstly:

Export and SVG file from Stitch Era
•• Select hotfix tab
• Choose Export hotfix
In the popup window:
•• Select SVG as output
•• Depending on how you plan work, you can decide to merge all designs into one page. To do so, drag all the

"Bead" objects to the right into the first page. Otherwise, Stitch Era will create a different SVG file for each bead
type used, e.g. that differ in size, color and shape.

• We suggest to tick Frame at the bottom of the popup and set a 1cm margin

Export hotfix to SVG, "Frame" is not ticked, i.e. we will have to add our own cutting rectangle in the vector graphics
program

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-export-hotfix.png
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Clean up the SVG for laser cutting
• Open the exported SVG file in an SVG editor, e.g. Inkscape
•• Draw a frame (cut line of the whole template), if it was not generated by the exporter, i.e. ticked (see just above).
• Make the strokes hairline width (<= 0.1mm) and choose an appropriate color (We use red (255,0,0) to define

cutting lines with our Trotec)

Fix cutting lines in an SVG editor

• Check the document size. It should be at least slightly bigger than the drawing including the frame. (In Inkscape,
menu File->Document Properties Resize page to drawing or selection. Make very sure to add this
padding, e.g. between 1mm and 1cm to each side. Adding a larger border is easier for brushing the stones, but
requires more space.

At the end you should have an SVG design that includes the cutting lines for the holes and the template itself. Below
is an example:

http://edutechwiki.unige.ch/mediawiki/index.php?title=Using_Inkscape_for_laser_cutting
http://edutechwiki.unige.ch/mediawiki/index.php?title=Trotec_Speedy_100R
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-export-2.png
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Read to print SVG hotfix template. Click and click again to retrieve the SVG if you want to use it
yourself

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHotfix-template-hamburger.svg
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Send the file to a laser cutter
•• Send to the cutter and select material type and thickness.

Trotec JobControl Interface - Cutting parameters for thick paper.

Example template
The result of the design discussed above is shown with the two pictures below. The cardboard template is too thin,
but it was just a test. I probably will use 0.8 mm Acrylic and also make the extra radius a bit small. A good laser
printer is fairly precise, more then a cutting plotter.
I also got an overlap warning in Stitch Era that I ignored. Such errors can either be fixed manually or automatically
(click on Solve overlap). Heavy overlap must be solved. One also can very slight augment the distance between
stones. The default is 1mm I believe.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-export-3.png


Stitch Era - creating hot fix designs 47

Hotfix template printed on some random cardboard

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-template-3.jpg
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Hotfix template partially filled, holes are rather large for these SS16 - 3.8mm stones

Using the template with a heat press
• Read the hotfix stone article and maybe the description of the heat transfer press used at TECFA.

References
[1] http:/ / www. stitchera. com/ downloads/ Documents/ Era1140-9. pdf

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hotfix-template-1.jpg
http://www.stitchera.com/downloads/Documents/Era1140-9.pdf
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Stitch Era - creating embroidery with hot fix
stones

Introduction
This beginner's tutorial for the Stitch Era embroidery software explains how to create embroidery designs that
include hotfix stones.
Tutorial home page

Stitch Era embroidery software
Learning goals

Digitize a vector graphic into an embroidery plus hotfix stones
Prerequisites

Stitch Era - creating embroidery from vector images
Stitch Era - creating hot fix designs

Related pages
Hotfix stone

Materials
You can reuse the pictures. In the wiki, click on picture to make it larger, then click again and save it.

Quality and level
This text should technical people get going with Stitch Era. I use it for an optional master degree course in
educational technology.

Last major update
October 2017.

This tutorial will combine some concepts and procedures from two other other tutorials, i.e. Stitch Era - creating
embroidery from vector images and Stitch Era - creating hot fix designs. We will go through two simple examples.
In the first, embroidery dominates, in the second hotfix stones are more important.

Rocket Example
Let's create a little rocket with nice crystal windows. We can find one on OpenClipArt
• Download Rocket icon [1] By pitr
•• Make sure to get the SVG file, e.g. click on the picture and then save as.

Resize the rocket in Inkscape
Since the Rocket is fairly small we would like to make it bigger, i.e. make it fit into a 10cm by 10 embroidery hoop.
According to our experience, scaling works better in a vector editing tool. However, as you shall see, the result won't
be usable, but for a mysterious reasons, scaling the drawing before does something good.
• Open the Rocket in Inkscape
•• Select all, ungroup
• Open the transform menu (CTRL-SHIFT-m or Menu Object -> Transform)
•• Tick "scale proportionally"
•• Enter 95mm or 40 mm if you prefer a smaller size. 9.5 x 9.5cm can be considered a fairly large embroidery for

this type of drawing.

http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_embroidery_software
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_embroidery_software
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_creating_embroidery_from_vector_images
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_creating_embroidery_from_vector_images
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_creating_embroidery_from_vector_images
https://openclipart.org/detail/22539/rocket-icon
http://edutechwiki.unige.ch/mediawiki/index.php?title=Inkscape
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•• Save the file as plain SVG.

Import the scaled SVG rocket to Stitch Era
•• Define a hoop size. We suggest 10 x 10cm
Artwork tab -> Open Vector file. You now should see the rocket. As you can see, Stitch Era does not take into
account scaling using viewports as Inkscape does.

Imported resized SVG Rocket, too small

Adjust the size in Stitch Era
•• Click on the rocket (do not use CTRL-A)
• Ungroup (using either the context menu or Artwork->Layout tab->Ungroup ALL)
•• CTRL-A
• Artwork->Layout tab
•• Set width to 90 (not 95, because we will need some extra space) or less, e.g. 40 if you want a small embroidery.
• Reposition in the middle (You can use the To Design tool in the ribbon bar, i.e. align horizontal and vertical with

respect to the Design, i.e. the hoop).

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-rocket-1.png
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Resize the rocket

Save the file as, e.g. rocket-1.dsg

Adjust the size of the borders
The black borders of the parts (i.e. yellow body, blue windows and red fins= are too small for nice satin stitches.
Let's make them just a bit bigger for now, i.e. 2mm.
•• CTRL-A
•• Vector Tab
•• Set thickness of lines to 2mm as shown in the screenshot below.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-rocket-2.png
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Resize the rocket

Save the file as, e.g. rocket-2.dsg

Flatten the drawing
This is not totally necessary for this rocket, since only the windows will overlap the yellow area. But make sure to
recall this in case you work with another rocket. Most often vectors drawings use several shapes that are piled on top
of each other. In embroidery, one normally uses single layers (plus a bit of underlay), otherwise the stitched design
will get very stiff and can break needles, etc. Anyhow, in our case we also will "carve out" the windows from the
yellow body.
•• CTRL-A
•• Layout Tab
• Combine vectors -> Simplify
After simplifying vectors you may have to add some overlap again in cas the test print shows that embroidery areas
have some emptry space (e.g. tissue showing through) between sections. But that is a matter for more advanced
users.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-rocket-3.png
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Digitize the rocket
Now let us translate the drawings to embroidery objects. Read the Stitch Era - creating embroidery from vector
images tutorial first, if you don't understand the concept. Below we just outline the steps.
•• CTRL-A
•• Embroidery tab
•• Art to stitch
•• Select Art to stitch (intelligent)
• Select Objects to fill -> Fill Areas and Borderlines (we do want to keep the black borders)
•• Select Artwork Unaltered (or process overlaps if you didn't simplify your geometry)
To verify the result, tick on Embroidery. If stitches are not yet generated, then hit F9 (or FN f9 on some computers)
or the lightening icon on top. Verify if the black borders overlap with the yellow and red parts. In principle they
should. Otherwise, make then bigger.
Save the file as, e.g. rocket-3.dsg
Before you move on, we just would like to recall that you can hide or show various types of objects, i.e. auxiliar
(includes the vector graphics), embroidery sections and hotfix designs. The main menu bar below the the ribbon
menu bar includes buttons that you can tick on or off for viewing / hiding. If the button is greyed, objects to not
exist.

Hide/unhide buttons in the main menu bar

If you are unhappy with the stitching, you can change the parameters of the various stitch sections (see the Stitch Era
- adjusting stitch sections tutorial). You also can kill all the Sections and start digitizing again. Warning: Each time
you digitize a vector object it will create a new stitch (or hotfix section) and keep the old one !

http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_creating_embroidery_from_vector_images
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_creating_embroidery_from_vector_images
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-Era-17-main-menu-right.png
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_adjusting_stitch_sections
http://edutechwiki.unige.ch/mediawiki/index.php?title=Stitch_Era_-_adjusting_stitch_sections
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Remove the stitched rocket windows
As planned, we would like to used hotfix stones instead of embroidery for the windows.
• Untick Auxiliar in the menu bar. Since you need to preserve all the vector drawings for the windows it is better to

hide the drawings. This way cannot kill any by mistake !
•• Open the Object manager (to the right, see the previous screen capture). You now can see the document map

panel to the right.
•• Kill the blue window stitch objects
•• You also can kill the black circles surrounding the blue window. As you can see by clicking on the black path in

the Object Manager, we got two times three borders. One times three borders is enough, unless you do want
doubly stitched ones.

Kill the stitch areas and lines for the windows

Now, to create the windows, you either you could a single SS34 stone for each window or many tiny ones, e.g. SS6
(2mm).

Option A: Add small hotfix stones
You now can fill the windows of the rocket with a few small hot fix stones. Else if you only need on large stone,
jump to the next section.
•• Tick Auxiliar and untick Embroidery in the menu bar
•• Select the three windows (hold down the CTRL key while you select one by one)
•• Open the Hotfix Tab
• Menu Single Hotfix fill -> Areas with Hotfix - Uniform fill
•• Untick Auxiliar
•• Select the three hofix areas
• Set the stone size and other parameters. The following picture shows SS6 size, 0.6mm distance, and HF Inner

Ring Fill pattern. You also could manually add a stone in the middle (see below)
•• Tick the embroidery tab to see the result.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-rocket-4.png
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Windows made with 7 2mm stones

Windows made with 7 2mm stones, stone in the middles added manually

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-rocket-5.png
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-rocket-6.png
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Windows made with 7 2mm stones

Option B: Add a single stone for each window
Adding individual stones and editing is explained in more detail in the Stitch Era - creating hot fix designs tutorial.
•• Untick Auxiliar and Embroidery and tick Hotfix
•• Kill all the hotfix areas
•• Tick Embroidery
•• Hotfix Tab
•• Click on Manual
•• Now a bit tricky: Open Manual Hotfix / BEAD tab before clicking and select the right stone size. If it is not in the

palette, you can add it using "Add bead".

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-rocket-7.png
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Windows made with single 7mm (SS34) stones

•• To fine tune positions of stones, use the Edit Hotfix menu (on top of the stones palette to the left)
•• To exit manual setting or edit hotfix, open another tab and click on something.
Read Stitch Era - creating hot fix designs for some more explanation.

A result
The following picture shows an example of my private main use for embroidery: stitch holes in sweaters (pullovers).
This one had two moth holes. But I like it simple. The small rockets are 4cm in size, i.e. fit into a small 5x5cm hoop
of our Brother PR1050X with some space to manoeuvre. After embroidery, I just put this Merinos wool sweater in
the heat press on top of some baking paper. I then added the hotstones manually, put some baking paper on top and
then pressed at 200C for 20 seconds.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-rocket-8.png
http://edutechwiki.unige.ch/mediawiki/index.php?title=Brother_PR1050X
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Rockets with crystal windows on Merinos Wool

To improve: The rocket was too small to cover one of the moth holes, so I had to stick a second one over the first
one with a result that is frankly not professional. However, the sweater is usable again. Tip: When you design
something to cover a moth hole make it rather round and have stitches overlap, i.e. not "empty" spaces. Also make
sure that it is at least four times as big as the hole and that you can reposition the embroidery with the control
interface (to avoid rehooping if the position is a bit wrong). Instead of taking a practical 5x5cm hoop, consider using
a 10x10cm hoop.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ARocket-on-pullover.jpg
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Overlapping rockets with crystal windows on Merinos Wool

We also might have used some denser fill (right now the yellow, red and violet parts are 5 lines/mm) or put some
product on the wool to flatten it down.

Hamburger Example
This example shows how to combine hotfix areas with some embroidery lines. We shall create a hamburger with a
little monogram inside.

Import and arrange vector file

Cheeseburger icon.
Copyright Mikicon [2],

downloaded from 317585
[3] by DKS, reproduced

with permission

The Nounproject [4] is very useful site that includes over a million icons. If you
acknowledge the author you are allowed to use any icon for your own use, but you do
have to register (it is free). If you pay 40$/year (half for education) you can use these
freely and more easily. Of course, I do pay an annual fee since I use these fairly often
and since such initiatives should be supported.

• Get file 317585 [3] from the noun project (and register if not already done so). If you
cannot do this, you can take it from the picture to the right (click three times on it
until you land on the SVG page, then "save it as"), but please understand that you will
have to acknowledge the original author.

• Import to Stitch Era: Artwork tab -> Open Vector file
If you do have a noun project membership (40$year/or less) you will see this (otherwise
you will have to remove something): A really small hamburger: 9x9.4mm. We want ours at least 10 times as big. We
also want to ungroup the elements.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ARocket-on-pullover-2.jpg
https://thenounproject.com/mikicon
https://thenounproject.com/mikicon/collection/burger-world/?i=317585
http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3ACheeseburger-noun_317585.svg
https://thenounproject.com/
https://thenounproject.com/mikicon/collection/burger-world/?i=317585
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Hamburger original, defined as a group of 6 vectors

•• Now, select all (CTRL-A),
• Artwork -> Layout tab. Enter 90 for the width (left in the ribbon menu)
•• Select the object, i.e. click on it
• Ungroup, either in the right-click menu or in Artwork->Layout; Ungroup All button to the right in the ribbon

menu
Adjust the view so that you can see all the objects
•• CTRL-A
•• F6 (or FN-F6) or click the Zoom Area button in the main menu bar
Click on one object. You can see in the ribbon menu that (a) the lines are vectors and (b) that they are not really lines
(as in strokes) but fills without borders (strokes). If you like, you can change its color as shown in the following
screen capture.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hamburger-1.png
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Hamburger original, 1000% bigger, defined as a group of 6 vectors

In order to fill these objects with hotfix stones we will have to transform these curves into solid surfaces. There are
several ways to do this. In Stitch Era we simply can remove "holes".
•• Select all objects
•• Make them objects with borders
•• Set the thickness to 2.
•• Now for each of the six objects: Select each one and click on "Remove holes" in the Layout tab. I suggest opening

the object manager on the right and then click on the items in the list one by one.

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AStitch-era-17-hamburger-2.png
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Add borders to each object

Close holes

Now we shall subtract the three rounds from the bread on top:
• Select the top "bread" first (this is important), then select the three round "holes"
• Layout tab -> Combine vectors -> subtract.
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Subtract

Now we have only three vectors left that we will translate to stitch objects.
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Transform the borders into embroidery
•• CTRL-A
•• Select Embroidery tab
• Art to Stitch -> Art to Stitch (intelligent)
• Select Fill Borderline Only

Stitch borders only

Strangely enough the generated stitches are running stitches. At a thickness of 2, they should be zigzag.
•• Open the object manager
• Click on each path (including the ones in the sections pack). In the fill style, select zigzag.
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Change fill style from path to zigzag (if you like)

You now got an embroidery:
•• Hit F9 and then F7 to see the result.

Stitch design ready to go
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Depending on your taste an textile you now could adjust underlay and density. Otherwise export as embroidery file
and give it to your machine.

Transform the fills into hotfix areas
•• Hide the embroidery objects (click on the green embroidery button in the main menu bar).
•• View the vectors again by clicking on the red Auxiliary buttons.
•• Select all: CTRL-A
•• Open the hotfix tab
• In the Single Hotfix Fill menu (in the middle of the ribbon bar, not to the left !), select Area with
Hotfix - Inner Ring Fill

Hotfix inner ring fill

Now
•• Untick Auxiliar
•• Tick Hotfix (far right in the main menu bar)
•• Hit F9 (if you cannot see the hotfix pattern)
The hotfix looks quite good, but it uses 4ss stones, i.e. really tiny ones that are difficult to handle. We prefer working
with 16ss (3mm) for now. Select all, then adjust stone size and other settings. I used:
•• SS16
•• 1mm separation
Hit F9 (or maybe FN-F9 on your machine) if you cannot see the changes. Also, you could add a simulated
background using the little "B" menu on top of the palette to the left of the workspace. Show the embroidery again.
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Hotfix fill with 16ss stones (not optimal) and embroidery

Now you should manually fix two things.
•• The lower bread has too much empty space. Consider making it a bit fatter without exiting the hoop space of

10x10cm. We moved the two objects on top upwards a bit to make some space.
•• On top there is some overlap, either let Stitch Era fix this or (better) do it yourself. E.g. remove the three

offending stones.
Finally, export the hotfix design to SVG (Hotfix tab -> Export Hotfix -> Export Hotfix to file. Select SVG or
whatever is suitable for your cutter.
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Heat transfer
After I did the first example described above, I got some good transfer paper from an online store and this time the
stones stuck very well.

Embroidery first. This tissue probably would need more stabilizing (I used a simple auto-adhesive), or at
least larger zigzag stitches

http://edutechwiki.unige.ch/mediawiki/index.php?title=File%3AHamburger-hotfix-embroidery-1.jpg
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1mm cardboard template filled with 16ss stones, using the "flat mousse brush" technique
explained above.

The three large 34SS did not stick after 20 seconds of heating. I then glued them with an applicator
Peeling off the stones from the template went really well. All stones stuck.
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Stones sticking to the (turned) transfer sheet
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In the heat press, ready to go
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Result

The result was satisfactory for my first "larger" hotstone design and my first use of transfer paper. I should improve
the embroidery (zigzags pulled too much into the textile) and probably make a larger design. The monogram is also
fairly ugly (too small). I then should try smaller stones.
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